COBOL-IT Developer Studio is COBOL-IT’s Integrated Development Environment.

The Developer Studio allows you to develop, debug and maintain your legacy COBOL applications in a highly configurable project-oriented environment.

The COBOL-IT Developer Studio is integrated with the Eclipse framework.

THE ADVANTAGES OF OPEN SOURCE IN COBOL-IT AND ECLIPSE

The COBOL-IT Developer Studio is an Eclipse-based development environment.

Eclipse is the most widely-used Open Source development environment framework and benefits from a mature toolset, a very well-developed knowledge base and broad portability.

Using the Eclipse development framework, the COBOL-IT Developer Studio provides the ability to manage projects on every Windows/Linux/Unix platform on which the COBOL-IT Compiler Suite Enterprise Edition is available.

With the Developer Studio, you can create COBOL Projects which you can Build, Run and Debug, both on local host machines and on remote host machines.

AVAILABILITY ON WINDOWS AND LINUX

COBOL-IT provides the Developer Studio on all the major Windows and Linux platforms.

With the addition of the Remote System Explorer, your COBOL projects can be located on any Unix, Linux or Windows platform provided you have a COBOL-IT Compiler Suite Enterprise Edition installed on that platform.

The Developer Studio will locate the COBOL-IT setup script on the host platform and use the host Compiler Suite for the key Build, Run and Debug functions.

COBOL-AWARE CODE EDITOR

With its COBOL-aware Code Editor and its integrated Debugger, the Developer Studio enhances your ability to develop and maintain your Legacy COBOL applications.

The COBOL-IT Code Editor allows for the Colorization and Capitalization of Reserved Words.

Configurable hot keys, pre-defined code fragments that can be inserted into the source by pressing a hot key, tab settings, line numbers, support for ANSI and terminal source formats and more.

The COBOL-IT Code Editor will reduce the number of errors you make while coding and reduce the time it takes to correct them.

The COBOL-IT Code Editor automatically produces an Outline View of your code which provides an easy clickable interface to your code at the level of the Division, Section, Variables and Paragraph.
POWERFUL DEBUGGER

The COBOL-IT Debugger provides for the standard step into, step over, step return, run, terminate and disconnect functions.

In a source-level interface, it also provides for the ability to manage conditional breakpoints, view the values of variables in Hex or ASCII format as well as monitor variables.

The COBOL-IT Debugger can be configured to run with specific environment variables including File Trace information and Memory Dumps.

When debugging code that has been pre-compiled, the Developer Studio can be configured to debug either the original source code or the source code generated by the pre-compiler.

The COBOL-IT Debugger can be set to attach to a running process. With this capability, COBOL programs that are recalled from other applications, such as transactional monitors, can be opened in the COBOL-IT Debugger. The COBOL-IT Debugger can then be detached from the running process when the debugging is complete.

The COBOL-IT Debugger can switch between the host machine’s “C” debugger and the COBOL-IT COBOL debugger. This can be very useful when interoperating with programs written in “C”.

REMOTE SYSTEM PERSPECTIVE

You may need to compile and test your application on multiple platforms.

The COBOL-IT Developer Studio allows you to create Projects on remote machines. You can add existing source and data directories to your Remote Project, either by linking to the existing directory location directly, or by importing the directories into your Remote Project structure.

Interfaces exist for initializing the COBOL-IT Compiler Suite Enterprise Edition installed on the remote machine, so that you can access the local resources in the same manner as if all the resources were located on your own local desktop.

DATA DISPLAYER PERSPECTIVE

Allows you to browse and edit data in indexed, relative, and sequential files using ASCII and Hex editors.

The COBOL-IT Developer Studio provides the ability to open data files and display the contents in either Read-Only mode or in Read-Write mode. When open in Read-Write mode, the contents of the files may be edited using either an ASCII or a Hex editor. The Data Displayer uses a data dictionary (XDD file) generated at compile-time to interpret the data contained in a file. Data Displayer can be opened on either a local or a remote host, and supports multiple record formats.

CODE COVERAGE

Allows you to validate that all paths of code have been tested in a single, or series of run units.

Code Coverage records which parts of your COBOL code are executed during a particular program launch. Programs compiled with the code coverage compiler flag produce coverage information that is presented in the Coverage view.

Source Code in the COBOL Code Editor is automatically decorated to demonstrate whether lines of source were executed or missed in the run.
PROFILER

Allows you to view real-time memory and CPU usage, as well as statistical data on where your run unit spends elapsed time and CPU time.

Programs compiled with the profiling compiler flag produce profiling data that is presented in the Profiler View which includes Runtime and Paragraph tabs. In the Runtime tab, you have access to Memory and CPU usage, displayed in real time. In the Paragraph tab, you have access to paragraph-oriented statistical data, including number of times entered, time elapsed, CPU time elapsed, external calls, and time elapsed in external calls.

GIT PERSPECTIVE

Provides access the full range of functionality provided by the Git Source Code Control System.

The Git Perspective provides the ability to create a source code repository locally, or to access an existing source code repository hosted on the web. In addition to being the most widely-used open-source source code control system, Git provides mechanisms to set triggers for automated test servers such as Jenkins operating in the DevOps delivery cycle.

RSEGIT PERSPECTIVE

Allows you to work with existing Git repositories when operating in your Remote System Explorer Perspective.

Requires an RSE connection and an existing Git repository on the remote machine. Users then have access to Git functionalities from within their RSE connection.

MYLYN TASK MANAGER

Allows you to manage tasks locally, or using web-based incident management systems.

Mylyn is the task and application lifecycle management (ALM) framework for Eclipse. With connectors to popular issue management tools, Mylyn integrates other ALM tools into the Developer Studio as well, allowing it to greatly enrich the developer’s experience.

NEW INTERFACE FOR COMPILER FLAGS

Provides access to more compiler flags, while presenting related compiler flags together.

Developer Studio 2.0.0 also includes an updated interface for managing compiler flags. Updates have been made to the Window>Preferences>COBOL>Compiler, and Project>Properties>COBOL Properties dialog screens. Select the Enable source settings checkbox to enable compiler flag and script settings.
# COBOL-IT DEVELOPER STUDIO FEATURES AND BENEFITS

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>BENEFIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eclipse-based Development Environment</td>
<td>Includes a Developer Studio Perspective for work on local projects, a Debugger Perspective for Debugging Tasks and a Remote System Explorer Perspective for working on projects located on remote machines. The COBOL-IT Developer Studio is certified on Linux and Microsoft Windows platforms.</td>
</tr>
<tr>
<td>Highly Configurable Work Environment</td>
<td>Configure your workspace, populate your projects, set compiler flags and environment variables, build, and run the programs in your application. COBOL Compiler Flags and Environment Configuration can be done at the Workspace, Project, or Program level providing maximum flexibility.</td>
</tr>
<tr>
<td>COBOL-Aware Code Editor</td>
<td>Create programming templates, program hot keys, colorize reserved words, operate in free, or ANSI source format. Easily identify and correct compiler errors. Operate with files and folders on local or remote platforms. The Code Assist features include support for folding and unfolding code at the Section and Division levels as well as the capitalization of reserved words.</td>
</tr>
<tr>
<td>Remote Systems Perspective</td>
<td>Allows for the use of COBOL-IT Compiler Suites installed on remote machines. Allows for the use of Eclipse to create COBOL Workspaces, Projects and Programs on remote machines.</td>
</tr>
<tr>
<td>Access External Utilities</td>
<td>Maximizes the flexibility and adaptability of the Development environment to the specific needs of the user.</td>
</tr>
<tr>
<td>Powerful String Search functions that can be operated on the level or the Workspace from a selected directory including its subdirectories.</td>
<td>Allows programmer to quickly identify, and if necessary, modify all the occurrences of a given string, improving productivity. Allows programmer to refactor, so that when a variable name is changed, all usages of the variable name will automatically be changed as well.</td>
</tr>
<tr>
<td>Outline View automatically generated from source code.</td>
<td>Provides clickable entry points to specific points in the program. Increases efficiency with which the programmer can navigate the full body of source code, increasing productivity.</td>
</tr>
<tr>
<td>A Compiler Console View showing the output from the Build</td>
<td>Provides a very familiar view on the workings of the compiler, allowing for easy access to information about the state of the compile operation.</td>
</tr>
<tr>
<td>Debugger support for UTF-8 protocol</td>
<td>Enhances debugging capabilities. Provides the ability to display values in Hex, and in UTF-8 in the Variable and Monitor windows.</td>
</tr>
<tr>
<td>Debugger support for conditional breakpoints</td>
<td>Reduces the time to isolate an error and correct it by allowing for breakpoints to be executed only when described conditions are met.</td>
</tr>
<tr>
<td>Available for use with the Kepler and Neon builds of Eclipse</td>
<td>The Kepler build requires the JRE 6 and later. The Neon build requires the JRE 8 and later.</td>
</tr>
<tr>
<td>Data Displayer Perspective</td>
<td>Supports the browsing of relative, line sequential and binary sequential files, and the browsing and editing of indexed sequential files. Supports multiple KEYS, multiple RECORD formats, multiple START options.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Code Coverage</td>
<td>Records which parts of your COBOL code are executed during a program launch. Source Code in the COBOL Code Editor is automatically decorated to show whether lines of source were executed or not in the run.</td>
</tr>
<tr>
<td>Profiler</td>
<td>Profiling data provides access to Memory and CPU usage, displayed in real time and to paragraph-oriented statistical data such as number of times entered, time elapsed, CPU time elapsed, time elapsed in external calls.</td>
</tr>
<tr>
<td>Git Perspective</td>
<td>Provides access to the full range of Git functionality. One of the most widely used source code control system, Git provides mechanisms to drive DevOps delivery with triggers for test automation servers like Jenkins.</td>
</tr>
<tr>
<td>RSEGit Perspective</td>
<td>Requires an RSE connection and an existing Git repository on the remote machine. Users then have access to Git functionalities in their RSE connection.</td>
</tr>
<tr>
<td>MyLyn Task Manager</td>
<td>Mylyn is the task and application lifecycle management (ALM) framework for Eclipse. With connectors to popular issue management tools, Mylyn integrates other ALM tools into the Developer Studio as well.</td>
</tr>
<tr>
<td>New interface for compiler flags</td>
<td>Updates have been made to the Window&gt;Preferences&gt;COBOL&gt;Compiler, and Project&gt;Properties&gt;COBOL Properties dialog screens. Select the Enable source settings checkbox to enable compiler flag settings.</td>
</tr>
</tbody>
</table>

**PLATFORM SUPPORT**

For the most recent information about Platform Support for the COBOL-IT Developer Studio, please reference the COBOL-IT Port List.
ABOUT COBOL-IT


COBOL-IT is an efficient, open-source COBOL compiler and runtime system, available for Windows and Linux. With modern development tools based around Eclipse and Enterprise support provided by the industry experts in COBOL, COBOL-IT is the only credible open source COBOL provider for Enterprise IT systems.

Click here to learn more about COBOL-IT products and services.